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Copyrights 

Copyrights ©1993-2007 I.R.I.S. All Rights Reserved. 

The IRISPen Mini, the IRISPen Express, the IRISPen Executive, the IRISPen 
Translator software were designed and developed by I.R.I.S. OCR ("Optical 
Character Recognition") and Linguistic technology by I.R.I.S. 
I.R.I.S. detains the copyrights of the IRISPen Mini software, the IRISPen 
Express software, the IRISPen Executive software, the IRISPen Translator 
software, Read & Speak, the PBR ("Pen Bar Code Reading") technology, the 
PCR ("Pen Character Recognition") technology, the PHR ("Pen Handprinting 
Recognition") technology, the linguistic technology, the on-line help system 
and this manual. 

The I.R.I.S. logo, IRISPen, PBR, PCR, I.R.I.S. Linguistic Technology and 
Read & Speak are trademarks of I.R.I.S. 

All other products mentioned in this user's guide are trademarks or registered 
trademarks of their respective owners. 

CE and FCC conformity 
The IRISPen was tested to comply with the EEC standards (EMC Directive 
89/336/EEC amended by 92/31/EEC & 93/68/EC) as well as the FCC 
Standards for Home or Office Use (47 CFR Part 15 regulation & ANSI 
C63.4). 





 

3 

CHAPTER 1 
INTRODUCING THE IRISPEN 

WHAT IS THE IRISPEN? 

The IRISPen is a hand-held pen scanner and software that allows 
you to scan data and instantly convert it into real editable text 
with the OCR (Optical Character Recognition) technology of 
I.R.I.S. The result is directly available in any Windows or Mac 
application. 

 

Major applications 

You will use the IRISPen to scan and enter into your active 
application any of the following:  
- notes and short entries like addresses, phone numbers, etc.,  
- figures and tables from checks, invoices, bank statements, etc., 
- excerpts of texts from books, magazines, newspapers, etc.,  
- small graphics like signatures, logos, handwritten notes, etc.  
Depending on the IRISPen version used, you will also able to read 
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barcodes, handprinting, dot matrix text, scan multiple lines at a 
time, or even read out or translate the scanned lines.  

The IRISPen series 

Here is the IRISPen series. Each version offers a different range of 
functionalities. 
- IRISPen Mini (+ Asian version) 
- IRISPen Express (+ Asian version)* 
- IRISPen Executive (+ Asian version)* 
- IRISPen Translator 
(*) Available for Windows and for Mac OS X. 

IRISPen  
Mini 

IRISPen 
Express 

IRISPen 
Translator 

IRISPen 
Executive 

Basic features Basic features Basic features Basic features 

User interface in  
15 languages 

User interface in 
15 languages 

User interface in 
15 languages 

User interface in  
15 languages 

47 recognition 
languages 
+ 4 languages in 
Asian version 
(*) 

121 recognition 
languages 
+ 4 languages in 
Asian version 
(*) 

121 recognition 
languages 
(**) 

121 recognition 
languages 
+ 4 languages in 
Asian version (*) 

Programmable 
pen buttons: 4 
possible 
operations 
(simple click 
only) 

Programmable 
pen buttons: 5 
possible 
operations 
(simple click 
only) 

Programmable 
pen buttons: 12 
possible 
operations 
(simple and 
double click) 

Programmable 
pen buttons: 13 
possible 
operations 
(simple and 
double click) 

 Customizable 
hotkeys 

Customizable 
hotkeys 

Customizable 
hotkeys 

 Save default 
settings 

Save default 
settings 

Save default 
settings 

 IRISPen Wizard IRISPen Wizard IRISPen Wizard 
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 Replace vertical 
lines 

Replace vertical 
lines 

Replace vertical 
lines 

  Delimiters Delimiters 

  Multiline 
scanning 

Multiline 
scanning 

  Speech synthesis Speech synthesis 

   Image 
adjustment  

   Replace 
character string 

   Customizable 
character subset 

   Reading of 
 handprinting 

   Reading of 
dotmatrix 

   Reading of 
barcodes 

   Reading of 
CMC7 

  Translation of 
recognized data 

 

(*) The Asian version of the IRISPen allows you to recognize 4 additional 
languages: Traditional Chinese, Simplified Chinese, Japanese, Korean. 
(**) No Asian version available. 
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The pen scanner 

 

The IRISPen is a pen scanner that has the size and shape of a 
highlighter. It connects to your computer's USB port and does not 
require any external power supply. The IRISPen is equipped with a 
scanning head and a line guide, a roller, and two programmable 
buttons.  
The line guide is used to properly position the pen on the line to be 
captured.  
The roller enables to easily roll the pen onto the paper and acts as a 
start switch.  
The two pen buttons are programmable. 
When you press the IRISPen onto a piece of paper, you turn it on, 
and when you lift the IRISPen away, the scanning ends. A green 
beam lights up the text area as you scan it.  
  

The OCR technology    

The IRISPen integrates the latest OCR (Optical Character 
Recognition) engine developed by I.R.I.S. It is able to recognize 
lines of text with top accuracy in up to 125 languages. All 
American and European languages are supported, including 
Central-European languages. Greek, Turkish, the Cyrillic 
("Russian") and the Baltic languages and Hebrew are also 
supported. Optionally, the IRISPen reads Asian documents in 
Japanese, Simplified Chinese, Traditional Chinese and Korean. 
The IRISPen reads virtually any font, in a wide variety of styles 
and point sizes (from 8 to 20 points), as well as special characters, 
reading marks, special symbols, and formatting elements such as 
vertical lines separating table cells.   
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HOW DOES IT WORK? 

The IRISPen functions as a camera that sends an image to the 
computer. The image is recognized by the recognition routines. The 
"read" data is inserted in the target application. 

To scan the data with the IRISPen, you must simply slide the pen 
scanner over the line of text or area. 

 

Operate as follows:  

• Hold the IRISPen like a pencil and place it a few millimeters 
before the first characters or data to be recognized. The pen 
scanner must be positioned so that the text line to be read is right 
in the center of the scanning head, directly under the guide 
line.  
 
! Yellow is the IRISPen's invisible color. It cannot be picked up 
by the scanner. Do not scan any data printed in yellow.  
 
Also see:  Learn how to... Scan from right to left, Scan vertical 
text (optional), Scan negative images. 
 
Warning:  
The pen scanning band is 0.41" (10.5mm.) high and covers in 
many cases several lines of text. As the pen only picks the 
"central" line within the scanning band, position the line to be 
scanned properly.  
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• Press the pen onto the paper and roll it over the text line at a 
steady rate. Once pressed, the start switch is activated and the 
data is illuminated by a green light.  
 
Warning:  
Make sure you hold the pen at the correct angle, otherwise the 
data may not be scanned properly. 

Correct position 

 

Incorrect positions 

        

• Once you have reached the end of the line, lift the IRISPen. 
Make sure you lift it after the last character of the line.  
 
! Do not scan a line longer than 12" (30.5 cm). The scanning 
stops as soon as this line length is exceeded.  

• Operate exactly the same way for the next line.   
 
Also see: Learn how to... Scan multiple lines. 

Tip:  
Check the image you generate 
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Use the Image Quality Check and the Scan Test windows (see: Starting 
up, User interface) to check the quality of the images you produce and 
improve your scanning skills. 
  

Tip:  
Train yourself with the testsheets 
We recommend you use the testsheets provided with your IRISPen to 
experiment and get acquainted with the pen scanner. The testsheets are 
available as printed matter as well as in PDF format for possible reprint (the 
testsheet.pdf file is automatically installed in the installation folder). 

THE STEPS TO FOLLOW... 

Here are the main guidelines to follow for using your IRISPen. 
Detailed instructions are provided later in this manual . Use the 
Table of Contents and the Index at the end of the manual to find the 
needed information.    

1. Define your settings in the IRISPen application 

Before you start using the IRISPen, you must tune the software. 
Depending on the type of data you intend to read - text, barcodes, 
dot matrix text, etc. - and in which language, you must select the 
appropriate basic settings and if necessary, fine-tune these settings 
via the frequent commands.  
See: Basic settings and Frequent commands. Also refer to the 
section Learn how to...  for more details. 

2. Open the target application and position your cursor 

Choose the application in which you want to insert the read data: 
open your target document, spreadsheet, database, etc. Place your 
cursor at the position where you want to insert the data.  
You can choose the way the data must be transferred in the active 
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application: either direct transfer or via the clipboard. See: Basic 
settings, Target.  

3. Take the original document and scan the data to be picked up 

Get back to the document, magazine, etc. containing the data to be 
transferred and scan the data with the pen scanner: simply slide 
your pen over the text lines, images, etc. Scrupulously follow the 
instructions given under: Introducing the IRISPen, How does it 
work?. After each scan, the data instantly appears in the target 
application.  

Important tip:  
Check the scanning quality 
Check the quality of your first scans before you actually start with definitive 
scanning. Use the Image Quality Check and the Scan Test windows (see: 
Starting up, User interface) to judge the image quality and the recognition 
results. If necessary, operate some image adjustments in the Scan Test 
window.. 
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CHAPTER 2 
INSTALLATION 

SYSTEM REQUIREMENTS 

Here is the minimal system configuration required to use the 
IRISPen:  

• A Pentium-based Intel PC or compatible. A Pentium III-based 
PC is recommended.  

• 64 MB RAM. 

• 100 MB of free hard disk space.  

• The Windows Vista, XP or 2000 operating system.  

• A free USB port to connect the IRISPen scanner.  

• A Windows compatible sound card to use the Speech Synthesis 
function of the IRISPen Executive. (For quality sound, 
preference should be given to a 64-bit sound card. All Windows 
compatible audio cards are supported). 

INSTALLING THE IRISPEN SOFTWARE 

The IRISPen package contains the pen scanner itself and a self-
running CD-ROM containing the IRISPen software. You must 
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install the IRISPen software before you install or connect the pen 
scanner.   

Caution: 
Please install the IRISPen software before connecting the pen scanner! 

To install the software:  

• First start your computer and log onto Windows.  
Caution: You must log on as administrator or make sure you 
have the necessary administration rights to install the software.   

• Insert the CD-ROM in your CD-ROM drive.  
Users of Windows Vista:  
Click on Run menu.exe to install the program, then follow the 
on-screen instructions.  
Users of Windows XP and Windows 2000: 
Simply wait for the installation program to start running. Should 
the installation not begin to run automatically, run the menu.exe 
file located on the CD-ROM.  

• Click on "IRISPen" to start the installation of the IRISPen 
(additional software products from I.R.I.S. are proposed for 
evaluation: Readiris Pro and Cardiris LE).   

• Choose the installation language and click OK.  

 

• Accept the terms of the license agreement. 

• Installation options are offered. Select the required options and 
click on Next each time you are ready to get to the next screen.  
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Dictionaries 
Do install the dictionaries as this improves the OCR accuracy. 
Adobe Reader 
If necessary, install the Adobe Reader software, which is 
required to access the software documentation (the user's guide 
is available in PDF format). 
Speech synthesis 
Select the language for the speech synthesis.  
Caution:  
Users of Windows XP must ignore the following message and 
click on Continue Anyway to continue the installation 
procedure: 

 

• Users of Windows Vista must confirm the installation of the 
device software by clicking on Install. 

• When the installation is complete, click on Finish, then remove 
the CD-ROM from the CD-ROM drive.  

 

The submenu I.R.I.S. Applications - IRISPen under the 
Windows Programs menu is created automatically by the 
installation program.  
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The installation program also creates a shortcut for the IRISPen 
application on the Windows desktop.     

 

INSTALLING THE PEN SCANNER 

Once the IRISPen software installation is complete, you can install 
the pen scanner.  

To install the pen scanner:  

• Plug the pen scanner USB cable into a free USB port of your 
computer. A message confirms that the device has been installed.  

 

 

Caution:  
Users of Windows XP, Service Pack 2: the wizard offers to 
search for more recent drivers on the Internet. Select "No, not 
this time". 
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• Simply follow the on-screen instructions to install the IRISPen 
driver. Click on Next each time you are ready to get to the next 
screen.  

• Select Install the software automatically (recommended). 

Caution:  
Users of Windows XP must ignore the following message and 
click on Continue Anyway to continue the installation 
procedure: 

 

• When the installation is complete, click on Finish. 

Tip:  
Once the pen scanner has been installed (see above), it can be disconnected 
then reconnected without having to reconfigure or reboot the PC. Users of 
Windows XP should always reconnect the IRISPen on the same USB port, 
otherwise the device driver must be reinstalled. 
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UNINSTALLING THE IRISPEN SOFTWARE 

There is only one correct way of uninstalling the IRISPen: by using 
the Windows (un)install wizard. You are strongly recommended not 
to uninstall the IRISPen or any of its software modules by manually 
erasing the program files.  

To uninstall the IRISPen:  

• Exit the application and disconnect the USB connector of the pen 
scanner.  

• From the Windows Start menu, select Control Panel and click 
Add/Remove/Uninstall programs. 

 

• Select the IRISPen from the list and click the 
Uninstall/Change/Remove button to remove the software.  

• Follow the on-screen instructions. 

HOW TO GET PRODUCT SUPPORT?  

If you have registered your product, you are entitled to free product 
support. Contact I.R.I.S.:  

Europe 
- Hotline: 32-10-45 13 64 (working hours) 
- Fax: 32-10-45 34 43 
- support@irislink.com  
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USA 
- Hotline 1-561-921-0847 / 800-447-4744 (working hours) 
- Fax: 1-561-921-0854 
- support@irisusa.com   

HOW TO REGISTER? 

Don't forget to register your IRISPen! By doing so, you will:  
- be kept informed of future product developments and related 
I.R.I.S. products,  
- be entitled to free product support 
- be entitled to special offers on I.R.I.S. products 

How to register? 

Registration wizard 

You can use the Registration Wizard available from the Register 
menu (main toolbar). Simply follow the on-screen instructions.  
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Registration form 

You may also directly access the registration form on the I.R.I.S. 
Web site: http://www.irislink.com/register.  

Telephone 

Or register by phone:  
- Europe: 32-10-45 13 64 
- USA: 1-561-921-0847 / 800-447-4744 
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CHAPTER 3 
STARTING UP 

RUNNING THE IRISPEN 

To start the IRISPen:  

• From the Windows Start menu, select All Programs, I.R.I.S. 
Applications, then IRISPen, or click the application shortcut on 
your desktop.  

   

The IRISPen startup screen appears for a few seconds. It 
displays the version and copyrights of the IRISPen software.  
Next, the IRISPen Application window and two additional 
windows are displayed: the Image Quality Check window and 
the Status window. The IRISPen icon appears in the 
notification area of the Windows task bar.  
When running the software for the first time, one more window 
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automatically appears on top of the others, prompting the user to 
calibrate the pen scanner.  

 

• If you are running the software for the first time, calibrate the 
pen scanner. See: Starting up, Calibrating the pen scanner.  

USER INTERFACE 

The user interface is composed of 3 windows: the Application 
window, the Image Quality Check window, and the Status 
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window. The IRISPen icon appears in the Windows task bar and 
confirms that the application is running.  

The Application window 

 

The Application window is the IRISPen's main window. It contains 
a menu bar that gives access to all software commands, a toolbar 
for quick access to all frequent commands, and the a window pane 
containing the basic settings. 
The window can be minimized with a click on the Minimize button 
or on the OK button. To reopen it, simply double-click or right-
click on the Status window, or use the IRISPen icon on the 
Windows task bar (see below).   
 
The Image Quality Check window 
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The Image Quality Check window appears by default as a semi-
transparent window, below the Application window. When 
scanning, it displays the "raw" grayscale image of the scanned area. 
Its purpose is to enable the user to view and check the quality of his 
scans.     
You can easily drag the window to another position on your screen. 
The chosen position will be maintained if you save your settings.  
You can remove the transparency of the window with a right-click 
of the mouse.  
You can close the window. To reopen it, select Image Quality 
Check from the Application window's Options menu or use the 
IRISPen icon on the Windows task bar (see below).  
 
The Status window 

 

The Status window appears by default below the Application 
window. It displays the OCR options that have been chosen in the 
Application window.   
You can drag the window to another position on your screen. The 
chosen position will be maintained if you save your settings.  
You can close the window. To reopen it, you will simply select the 
option Status Window from the Application window's Options 
menu or use the IRISPen icon on the Windows task bar (see below).  

The IRISPen icon 

    

The IRISPen icon appears by default in the notification area of the 
Windows task bar. It confirms that the application is running and 
that the pen scanner is connected. If the pen is detached from the 
USB port, the notification area will indicate it.  
You can restore the application with a simple click on the icon. A 
right-click on the icon also allows you to enable the Image Quality 
Check window, the Status window, and the Scan Test window.  
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CALIBRATING THE PEN SCANNER 

Before you start using the IRISPen, you must calibrate the pen 
scanner. If you don't calibrate the scanner, the image quality will be 
low and the recognition results may be mediocre.  
You are automatically prompted to calibrate the pen scanner when 
running the software for the first time. All you need to do is push 
your pen on a white piece of paper for a few seconds. The 
software indicates when the calibration is complete.  

   

Caution: 
If the ambient light changes - imagine you get from natural to 
artificial lighting or conversely, imagine you move to a much 
lighter or darker place, or even move to a completely different 
environment, etc., you may need to re-execute the calibration of 
your pen scanner.  

Tip:  
Check the scanning quality 
You can always check the scanning quality in the Image Quality Check and 
the Scan Test windows (see: Starting up, User interface). If the image 
quality appears degraded, please re-execute the calibration of your pen 
scanner. 
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To re-execute the calibration:  

• Select Calibrate from the Options menu in the Application 
window or, from the Scan Test window, press the Calibrate 
button, then push again your pen on a white piece of paper for a 
few seconds. The software indicates when the calibration is 
complete.    

 

 

CHANGING THE USER INTERFACE LANGUAGE 

The user interface of the IRISPen is available in a wide range of 
languages. The language can be easily changed according to your 
needs.  

To change the user interface language:  

• Select User Interface Language from the Settings menu in the 
Application window.  

• Select the needed language from the drop-down list, then click 
OK to confirm.  
The user interface automatically appears in the newly chosen 
language.  
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THE SCAN TEST WINDOW 

The Scan Test window displays the black-and-white version of the 
image you generate with the pen scanner. The recognized data 
appears just below the scanned image.  
Thanks to the Scan Test window, you can test your first scans and 
check the results before you start with definitive scanning. If 
necessary, you can operate some image adjustments to improve the 
results. You can save your images, load and recognize previously 
scanned images, access the calibration dialog box, etc.  
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Bad quality images 
As you will notice, the IRISPen is able to recognize data on bad quality 
images, e.g. on low-contrast documents where the background nearly has the 
same color as the text, on highly distorted images with wavy, skewed or even 
contracted lines (see above figure). However, if the recognition result is not 
satisfactory, you should use the Scan Test window to make a few more tests 
and if necessary, adjust the image.  

To access the Scan Test window:  

• In the Application window, click the Scan Test button  on 
the toolbar or select Scan Test from the Options menu. 
As soon as you scan some data, the image produced appears in 
the upper part of the window. The recognized text is displayed 
just below the image.  Any unrecognized character is marked 
with the rejection symbol "~" (the rejection symbol can be 
modified - see: Learn how to... Define the symbol for unknown 
characters). 

 

Load image: this option allows you to load prescanned images and 
perform character recognition on them; the supported file format is the 
Windows bitmap (*.bmp) format. 
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Save image: this option allows you to save the images you generate; 
the available file formats are: black-and-white and grayscale Windows 
bitmaps (*.bmp).  

Calibrate: allows the user to re-execute the pen's calibration. 

Fit to window 

The option Fit to Window ensures that the entire image is 
displayed in the window, whatever the length of the scanned line 
may be. It is activated by default.  
When a long line of text is being scanned, you can deactivate the 
option. If you do so, the scanned line will no more be compressed 
horizontally and only a portion of the line will be displayed. You 
can use the image scroll bar to view the scanned data entirely.  

 

 

Recognize 

The Recognize option is activated by default. All images you scan 
or open are thus automatically recognized.  
Note that in the text zone, you can get directly to the end or the 
beginning of the recognized text: place your cursor in the text zone, 
then press the End or Home key from your keyboard. 
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The Recognize option is not useful when scanning graphics. If you 
have selected Grayscale image to clipboard or Black&White 
image to clipboard in the Application window, the Recognize 
option will be replaced by Image to clipboard.  

IMAGE ADJUSTMENT 

The image adjustment features enable to optimize the image 
generated with the pen for the recognition process. These options 
will be particularly useful if you scan very bad quality documents, 
documents with colored background, or low-contrast documents 
where the background virtually has the same color as the text.  

Tip:  
Remember that yellow is the IRISPen's invisible color. Do not try to make 
the IRISPen pick up any data printed in yellow.  

To operate some image adjustments: 

• Access the Scan Test window: in the Application window, click 
the Scan Test button  on the toolbar or select Scan Test from 
the Options menu. 

 

• Manually change the Brightness and/or Despeckle level(s). 
After each adjustment, the scanned image is directly adapted and 
the recognition re-executed if the Recognize option is selected.  
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Brightness 
Brightness means the black-and-white threshold of the image. 
The brightness adjustment is by default Automatic. You should 
leave this default setting for all normal documents.  
 
Manual 
When dealing with bad quality documents, changing manually 
the brightness level may level the quality of the black&white 
image and so improve the text recognition.  
To set the brightness manually, click Manual, then slide the 
indicator to the left (lighten) or to the right (darken). If you 
darken the image, more pixels become black in the black-and-
white image; if you lighten the image, less pixels become black. 
 
Despeckle 
 
The option Despeckle makes it possible to remove small spots 
from the images. By default, the option is turned off. 
To activate the despeckling, slide the indicator to the right. You 
can remove dots from 1 to 20 pixels.  
! Caution: Be careful not to erase spots that are too big, 
otherwise you may start erasing the dots on the letter "i", 
portions of dot matrix letters, etc.  

THE IRISPEN WIZARD 

The IRISPen Wizard offers the quickest and easiest way of defining 
your settings. It proposes a series of templates with pre-defined 
settings meant for the reading of certain types of data: text, text 
from columns, numeric tables, etc. These templates can be either 
used as such, or modified to fit more particular needs. Up to three 
(modified) templates can be further assigned to a preset button 
directly accessible from the Application window (or, alternatively, 
set to function as current settings). When it comes to actually 
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capture a certain type of data, all you need to do is press the right 
preset button, then start the scanning!  

By default, the preset buttons are already assigned to the reading of 
English Text, Text from columns, Text tables.  

The Wizard as well as the three presets can be accessed and 
activated directly from the toolbar. Once a preset button has been 
enabled, the corresponding settings become the current settings. 

 

Tip: 
To save time, do not hesitate to use the wizard extensively. First make up 
your mind about the types of data to be read. Second, "prepare" the software 
for the reading by defining the corresponding presets. Whenever needed, just 
select the right preset and start the scanning! 

You can save as many sets of settings as you wish. With the Save 
Settings and Open Settings options from the File menu, you will 
be able to save and reopen your custom presets and current settings. 
See: Learn how to... Customize/save/reopen settings. 

How to define presets with the Wizard?  

• Click the Wizard button  on the toolbar. The Wizard 
workflow is divided up into different steps. You will get from 
one step to the other by simply clicking on Next. 

• Step 1 
In the list of proposed templates, choose the template that 
corresponds to the type of data to be read, e.g.: text, numeric 
table, etc. Remember that a set of options is already pre-selected 
in the Wizard.  
Alternatively, select an already existing preset from the Presets 
tab. It will serve as basis for your custom preset. Select either the 
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current settings or one of the existing presets.  
Click Next to get to the next step.  

 

• Step 2 
If needed, change any of the basic settings: Reading options, 
Target, Scanning mode.  
Click Next to get to the next step.  

• Step 3 
If needed, change any of the settings related to the recognition 
process in the various tabs proposed.  
Click Next to get to the next step.  

• Step 4 
If needed, change any of the other settings in the various tabs 
proposed.  
Click Next to get to the next step. 

• Step 5 
Assign your settings to a preset button and give it a name, and/or 
apply your settings as current settings.  
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CHAPTER 4 
BASIC SETTINGS 

READING OPTIONS 

Scan type 

The Scan type determines the nature of the data to be scanned and 
read with your pen. Select the appropriate Scan type in the drop-
down list.  

 

Text (default value):  
To read machine-printed text in a certain language. This includes 
alphanumeric characters, punctuation marks, numeric data, etc.  
The set of characters used by the software to read such data directly 
depends on the language chosen for the reading. However, you can 
freely customize this character set (see: Frequent command: 
Character Subset).  

Numeric:  
To read machine-printed figures, numeric tables, etc. This includes 
special characters, mathematical symbols, punctuation marks, 
currencies, etc.  



IRISPen Executive 6 - User's guide 

34 

The set of characters used by the software to read such data is the 
same for all languages. You can freely customize this character set 
(see: Frequent command: Character Subset).  
Also refer to: Learn how to... Read numeric data. 
 
Black-and-white image to clipboard:  
To scan small black-and-white graphics such as signatures, 
mathematical formulae, etc. The image will be sent to the clipboard 
before it can be pasted into the active application. 
 
Grayscale image to clipboard:  
To scan grayscale or color graphics and send them to your clipboard 
before they can be pasted in a chosen application.  
 
Barcodes:  
To read barcodes. Select this option to read barcodes exclusively. If 
you want to read barcodes alongside other data, select the reading 
option Barcodes. The character string resulting from the reading 
will directly appear in the target application.  
You can also further fine-tune the barcode reading according to 
your needs (see: Frequent commands, Barcodes). 
Also refer to: Learn how to... Read barcodes.  
 
CMC7:  
To read CMC7 symbols.  
 
Handprinting:  
To read handprinted numbers and/or handprinted capital letters in a 
certain language.  
It is recommended to further adjust the handprinting settings (see: 
Frequent command: Handprinting).   
Also refer to: Learn how to... Read handprinting. 
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Language 

The option Language is used to indicate the language in which the 
data is to be read.  
Select the required language in the drop-down list. Either browse 
through the list or simply press the first letter of the needed 
language.  
You can freely customize the character set which is normally used 
to read the chosen language (see: Frequent command: Character 
Subset).  

 

Mixed alphabets 
 
You can activate a mixed alphabet of Greek or Cyrillic and Western 
characters. This is useful if Western words pop up in Greek of 
Cyrillic texts (this is often the case with proper names, brand 
names, etc.). The IRISPen will automatically switch languages 
whenever needed. In the Language drop-down list, select the 
required language pair, e.g.: Greek-English, Byelorussian-English, 
etc.  

 

Asian languages (optional) 
 
When choosing an Asian language, also indicate the text flow 
which is vertical rather than horizontal. See: Learn how to... Scan 
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vertical text.  
! Warning:  
If you use the XP operating system, check that the appropriate 
Regional and Language Options have been set to read Asian 
languages. From the Windows Start menu, select Control Panel, 
then Date, Time, Language, and Regional Options, then 
Regional and Language Options, Languages tab).  
If you use Windows 2000, check that it has been configured to be 
able to type the Asian language(s) required.  

 

 

Other 

 

Barcodes 

The option Barcodes is used to read barcodes on top of the data 
defined as primary scan type. This allows you to read text, numeric 
data or handprinting, as well as barcodes without having to get from 
one scan type to the other.  
Additionally, you can fine-tune the barcode reading (see: Frequent 
commands, Barcodes). 
Also refer to: Learn how to... Read barcodes. 
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Warning:  
If you choose Barcodes a secondary scan type, the reading results may be 
less accurate than if you choose Barcodes as primary scan type. If possible, 
scan thus your barcodes separately and choose Barcodes in the Scan type 
field.  

Dot matrix 

The option Dot matrix is used to make the pen read dot matrix 
symbols, i.e. symbols that are made of isolated, separated dots. 
Select this option if you intend to read so-called "draft" or "9 pin" 
dot matrix text.  
Also refer to: Learn how to... Read dot matrix text. 

Small print 

The option Small print is used to get optimized results when 
reading small printed text. Select this option if you want to read text 
with a font size smaller than 10 points.  
Also refer to: Learn how to... Read small print. 

TARGET 

You may choose the way the read data is being inserted in the target 
application: either via the clipboard, or directly in the application, 
without having to operate manually (see below).  

Tip:   
The formatting that is active in the target application will apply to the data 
which is being inserted in the application: if you have selected, say, Palatino 
12 point bold in the application, the text will be inserted in Palatino 12 point 
bold, whatever the original font or size may have been. 
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Clipboard 

If the option Clipboard is selected, the software will send the read 
data to the clipboard before you can paste it into the target 
application. You will then use the Paste or CTRL+V command to 
actually paste the data. 
Select this option if you want to manually paste the read data into 
your target application.   
 
! Remember that the clipboard can only contain the data of the last 
scan.  

Active application 

This option is selected by default. The recognized data will be 
directly inserted at the cursor position in the target application.   

Paste mode 
If you select Paste mode, the recognized data is first sent to the 
clipboard, then automatically inserted at the cursor position in the 
target application. This operation is totally transparent for the user.  
You should not normally use this option. However, if you notice that 
the characters inserted in the target application do not correspond to 
the ones actually recognized by the software (see: Starting up, The 
Scan Test window), enable it. 
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SCANNING MODE 

 

Single line 

The option Single line is selected by default. It is used to indicate 
that a single line is being read per scan.  

Multiple lines 

The option Multiple lines is used to scan multiple lines at a time. It 
is particularly useful to scan full excerpts from books, magazines, 
etc. The various lines of text are first kept in the IRISPen, then 
released with the click on a pen button.  
Select this option to indicate that several lines of text must be read 
within the same scan.  
Also refer to: Learn how to... Scan multiple lines. 
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CHAPTER 5 
FREQUENT COMMANDS 

PEN BUTTONS 

Your pen scanner is equipped with two buttons. The simple and 
double of each pen button can be programmed so as to execute an 
operation in the target application. By simply pressing the pen 
buttons, you will thus be able to execute keyboard commands, add 
characters, switch from a scan type to another, etc. without having 
to touch your keyboard.   

 

Tip:  
The buttons' programming is particularly useful, for example, when entering 
data into a database: you can program the <Tab> command to get to the next 
field and program the <Home><Cursor Down> to move the cursor to the 
next row. When entering amounts in a spreadsheet, you can program the 
keying of the currency ("$", etc.). In your word processor, you will program 
the <Enter> key to make a carriage return and start a new paragraph, etc. 
These are only a few examples... 

To program the pen buttons:  

• In the Application window, click Pen Buttons on the toolbar 
or select the command Pen Buttons from the Settings menu. 
The Pen Buttons window opens with a default programming.  
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• Modify the default programming by selecting the required radio 
buttons on the left- and on the right-hand side. The left radio 
buttons refer to the left button, the right radio buttons refer to the 
right button.  
 
Possible operations 
 
Null: This corresponds to a "null" operation. In other words, a 
single click will not trigger off any action.  
This option is usually used to deactivate a programmed 
operation.  
 
Custom...: This allows you to program your own custom 
operations, i.e.: any other keyboard command - including a 
combination of commands -, or the addition of characters, 
character strings, or even the combination of several operations.  
To enter the custom operation, select the required radio button, 
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then enter your keyboard commands or characters in the 
proposed field and click OK to confirm.    

 

Switch scan type: This allows you to program the switch to the 
next scan type in the list of scan types available (see: Basic 
settings, Reading options, Scan type).  
If the current scan type is Text, this will make you switch to 
Numeric. If the current scan type is Numeric, this will make 
you switch to the Black-and-White image. (Remember that the 
reading mode is always specified in the Status window). 
 
Enable dot matrix mode: This is used to enable the dot matrix 
reading mode.  
Undo last scan: This is used to remove the last scan that was 
inserted in the target application.  

• Click OK to confirm and close the window. 

DELIMITERS 

With the delimiters, you can indicate how the scanned lines must be 
delimited for the reading. Where should the reading actually start if 
a word has been cropped during scanning? How should hyphens be 
interpreted when occurring at the end of a line? Should keyboard 
commands or characters be added before and/or after the read line? 
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To set the reading delimiters:  

• In the Application window, click Delimiters on the toolbar 
or select Delimiters from the Settings menu. The window opens 
with an Input and an Output tab.  

 

• In the Input tab, indicate how the scanned area must be isolated 
and what the recognized text (output) should be. Delimit the text 
line according to the given example: "The quick brown fox 
jumps over the lazy dog".  
- keep all scanned characters   
- keep all characters before the last space 
- keep all characters after the first space 
- keep all characters between the first and the last space 

Ignore rejected characters in first and last position:  
It may be that characters positioned at the beginning or at the end 
of a line are not properly scanned/read. This may happen if the 
wordspacing is too small or if you scan text from columns, like 
in magazines, for example, and that you start scanning slightly 
on the previous word/column and end scanning on the next one. 
Those "bad" characters will automatically be rejected by the 
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software and represented by the "~" symbol in the Scan Test 
window.  
The best to do if you encounter such a situation is to make the 
software ignore the first and last position characters for the 
output, otherwise you will have to delete them manually once 
inserted in the active application.  

• In the Output tab, select the options according to your needs:  

 

Restore paragraph:  
You must indicate how to interpret hyphens occurring at the end 
of a line. If you scan the lines "The new presi-" and "dent waved 
from the balcony", the hyphen must obviously be dropped so as 
to recompose the word "president" in the output: "The new 
president waved from the balcony".   
Select this option in order to delete all the end hyphens occurring 
in your text.  
Note: If hyphens are deleted, the ending codes (see below) will 
automatically be deleted so that the words can be properly 
recomposed.  
 
Add starting code:  
You can have the IRISPen execute operations automatically in 
the target application before the output result is being inserted. 
You can for example have the software operate a carriage return 
before it inserts any read line. A series of possible codes are 
proposed by default, but you can also introduce your own 
starting code.  
To insert a starting code, select a code from the drop-down list or 
select Custom to introduce our own code, then click OK to 
confirm. With the Custom code, you can add any combination 
of keyboard commands and/or characters.  
The default starting code is: <None>.  
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Add ending code: 
You can have the IRISPen execute operations automatically in 
the target application after the output result is being inserted. If 
you insert data into a database, you can for example define a 
tabulation as ending code to automatically position your cursor 
in the next field. A series of possible codes are proposed by 
default, but you can also introduce your own ending code. 
To insert an ending code, select a code from the drop-down list 
or select Custom to introduce your own code, then click OK to 
confirm. You can add any combination of keyboard commands 
and/or characters.  
The default ending code is: <Space>.  

• Click OK to confirm and close the window. 

CHARACTER SUBSET 

The subset of characters used by the IRISPen to read data is set 
according to the Scan type and the Language chosen for the 
reading. As you can imagine, the subset of characters used for 
reading numeric data differs from the one used for reading text: the 
first one mainly contains figures while the second one also contains 
letters. Similarly, the subset used for reading English differs from 
the one used for reading French (think of the "é", "è", "û", etc. that 
do not exist in English), etc.  
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Character subset for the Text scan type in English: 

 

By using a specific subset of characters, the software eliminates the 
chances of recognition errors. For example, if you select the reading 
mode Numeric, you limit the set of recognized characters to 
numeric symbols only. By doing so, no confusion can possibly be 
made between "5" and "S", ""9" and "g", "8" and "B", etc. as the 
software automatically interprets the characters as figures. 

You can also by yourself go one step further and customize any of 
the proposed subsets of characters. You can create a character 
subset that exclusively contains those symbols you want to 
recognize. As an example, if you want to read amounts given in 
dollars exclusively, select the reading mode Numeric, then limit the 
character set to figures, punctuation and the "$" sign, and eliminate 
all other unnecessary symbols.    

To customize a character subset:   

• In the Application window, first select a type of data to be read 
(Scan Type field) and/or the language in which the data is to be 
read (Language field). The subset of characters proposed for 
reading such data will be automatically activated.  

• Click the button Character Subset on the toolbar or select 
the command Character Subset from the Settings menu. In the 
Character subset window, all the characters proposed for the 



IRISPen Executive 6 - User's guide 

48 

selected data type are enabled. All the other characters are 
disabled and grayed out.   
! Warning 
Handprinting: To customize the character subset for 
handprinting, you must choose the User-defined subset option 
in the Handprinting window then define your own subset. See 
how to adjust the handprinting reading in: Frequent commands, 
Handprinting.  

 

• To add or remove character(s) from the subset, simply click on 
the corresponding button(s). You can also select or deselect 
groups of characters using the buttons on the right-hand side: 
Deselect/Select A-Z, Deselect/Select a-z, Deselect/Select 0-9, 
Deselect/Select All.  

• Click OK to confirm and close the window. 

BARCODES 

The IRISPen allows you to fine-tune the barcode reading: you can 
limit the reading to specific barcodes, make the software verify/strip 
checksums, authorize partial read, or read out-of-specs barcodes.  



CHAPTER 5 - FREQUENT COMMANDS 

49 

To fine-tune the barcode reading:  

• In the Application window, click Barcodes on the toolbar, or 
select Barcodes from the Settings menu. In the Barcodes 
window, enable or disable the available options.  

 

Barcode types  
By default, the application is set to automatically detect and read any 
of the barcodes supported by the IRISPen (see: Learn how to... Read 
barcodes). All barcode types are thus selected by default. You can 
however limit the recognition to specific barcode types. This will help 
avoid any possible errors when reading a certain type of barcode.  
To limit the reading to certain barcodes, (de)select the corresponding 
buttons in the proposed list. 

Verify checksum 
This feature allows you to make the software automatically verify the 
barcode check character(s) when reading certain types of barcodes. To 
enable this verification, simply select the button Verify checksum in 
front of the barcode(s) concerned.  

Strip checksum 
Should you wish to, you can also have the barcode's cheksum stripped 
out from the recognition result. To exclude the checksum from the 
recognized barcode(s), simply select Strip checksum in front of the 
barcode(s) concerned. 

Barcode quality 
If you notice that the quality of the barcodes to be read is rather poor, 
you should make some adjustments manually. The software will use 
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additional intelligent routines to try and read the barcode. To indicate 
that the quality is poor, slide the quality indicator to the left. If 
necessary, make several tests using the Scan test window (see: 
Starting up, The Scan Test window).  

Allow out-of-specs barcodes 
It may happen that some barcodes have been generated without 
respecting the barcodes specifications. The IRISPen can be tuned to 
try and read such barcodes. Simply tick this option if you suspect the 
barcodes are "out-of-specs".  

Partial read 
It may be that only part of a barcode can be scanned. This may be the 
case if the end of the barcode is unavailable or of insufficient quality, 
etc. If you desire it, the partial scan can render a partial read, rather 
than no read at all: tick Partial read and indicate the limit under 
which the reading will not be accepted (in number of characters). If 
the number of read characters is below the limit, no result will be 
given. If it is superior to the limit, only the required characters will be 
recognized. 

Default 
The Default button is used to restore the default settings in this 
window.  

• Click OK to confirm the settings and close the window.  

Tip: 
Activating the Barcode scan type 
Once you have saved the Barcodes window settings by clicking on OK, the 
scan type Barcode gets automatically activated in the Application window. 
In other words, you can skip the Scan type selection and directly introduce 
the settings for the barcode reading.  

HANDPRINTING 

Before you start scanning handprinting with your IRISPen, the best 
is to let the software know with precision what type of characters is 
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going to be read: numeric, alphabetic, spaced or contiguous, etc. 
This will help the IRISPen work better and quicker. Refer to Learn 
how to... Read handprinting to know exactly what can be read by 
the pen.  
If needed, you can also make the software remove spaces, decide on 
the level of rejected characters to be accepted.  

To adjust the handprinting settings:  

• In the Application window, click Handprinting on the 
toolbar, or select Handprinting from the Settings menu. In the 
Handprinting window, modify the options as needed. 

Tip:  
Opening the Handprinting window automatically enables the scan type 
Handprinting. If you want to activate this scan type and adjust the 
handprinting settings, a click on the Handprinting button suffices.  
  

 

Character segmentation  
 
It is important to tell the software if the characters are well spaced or 
contiguous. If you try to read contiguous handprinting with the 
segmentation set to "spaced", some characters may be skipped in the 
recognition.   
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Contiguous handprinting: Select this option if the space between 
characters is reduced. In this case, some characters may occasionally 
touch each other and the zones covered by a single character may 
overlap.   

Spaced handprinting: Select this option if there is a clear space 
between the characters.  

Character subset 
 
It is important to specify the subset of characters to be used by the 
software as this eliminates the chances of recognition errors. For 
example, if you select the reading mode Numeric, you limit the set of 
recognized characters to numeric symbols only. By doing so, no 
confusion can possibly made "5" and "S", ""9" and "g", "8" and "B", 
etc. as the software automatically interprets the characters as figures. 
Set the subset of characters according to the type of characters to be 
read:  
 
Numeric: to read numbers, as well as the dot, comma and hyphen 
symbols.  
 
Alphanumeric: to read numbers and capital letters, as well as the dot, 
comma and hyphen symbols. 
 
Alphabetic: to read capital letters only.  
 
User-defined subset: to read a specific set of characters. Click on 
Subset and define your own subset by selecting/deselecting the 
required characters or groups of characters: Select/Deselect A-Z, 
Select/Deselect 0-9, Select/Deselect All. 
 
Remove spaces: this option makes the software remove spaces 
between characters in the recognition result. It is selected by default if 
you choose to read numeric data. If you intend to read whole phrases 
or sentences (of alphabetic or alphanumeric characters), you should 
not remove the spaces. The software will in this case detect the spaces 
between the words and reproduce them in the read sentence.   
 
Rejection level 
 
If you read numeric data, you can have an influence over the rate of 
rejected characters appearing in the recognition result. If the rejection 
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threshold is increased, characters will be rejected quicker if the 
software is unsure. There will thus be less possible errors but more 
rejected characters in the result. If the rejection threshold is decreased, 
there will be less rejected characters in the result, but the level of 
possible errors will be higher. For applications where extreme 
accuracy is essential, you should thus set a high rejection level.  
To adjust the rejection level, you must simply drag the slider bar to the 
left or to the right.  

Tip:  
Unrecognized characters/symbols are by default represented by a tilde (the 
"~" symbol) in the recognition result, but you can define another symbol that 
best fits your needs. See: Learn how to... Define the symbol for unknown 
characters.  

• Click OK to confirm the settings and close the window.  

SPEECH SYNTHESIS 

Thanks to the speech synthesis, you can make the IRISPen speak 
out the recognized data for you. Just scan some data and the 
computer reads it out for you! 
The speech synthesis feature is available in the language that was 
chosen at the installation for speech synthesis*. 

(*) Remember that you can possibly change the language supported by 
deinstalling then reinstlaling the IRISPen. The following languages are 
available: Brasilian, British English, Dutch, English, French, German, Italian, 
Russian.  
Practically, you will no longer need to look up to the screen to 
verify your recognition results. Think how useful this will be when 
encoding new data, entering data into your bookkeeping, etc. The 
IRISPen will also be a valued tool when learning a foreign 
language: the computer will pronounce all new words for you, etc. 

At any moment in time, you can also have the software repeat the 
pronounced lines. The IRISPen will always repeat the last utterance. 
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Tip:  
Speech synthesis applies to all legible data 
Speech synthesis not only applies to text but to all legible data such as 
handprinting, numeric data, and barcodes. You can thus activate the speech to 
get an auditive feedback of any type of data.  

To activate the speech synthesis: 

• In the Application window, select the language that was chosen 
at the installation for speech synthesis. 

• If you intend to read whole sentences, do not forget to select the 
scanning mode Multiple lines. This will ensure a natural 
prosody, a good intonation, and the insertion of pauses. 

 

• Press the Speech button  on the toolbar or select Speech from 
the Options menu. As soon as data is being scanned, it is spoken 
out by your computer.  
If the beep sound was enabled, it is automatically disabled and 
replaced by the speech.  

To repeat the speech:  
 
Right-click the button Speech on the toolbar or select the command 
Repeat Speech under the Options menu. The IRISPen will directly 
repeat the last pronounced utterance for you.  
Remember that you can always program a hotkey to repeat the 
speech - See: Learn how to... Program hotkeys.   

Tip:  
Do not enable the speech feature unless you really intend to use it. The 
recognition actually slows down as you wait for the recognized data to be 
read aloud.  
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BEEP SOUND 

The Sound option enables to activate a beep sound during the 
scanning: if you activate the beep, you will hear a beep sound when 
the pen scanner stops scanning and when the recognized data is 
being sent to the target application or clipboard.  

If the Sound option is enabled, you will also hear a beep sound 
whenever an error occurs or if you try to operate wrongly with the 
IRISPen.   

Caution:  
If the Speech option is activated, you cannot produce the system beeps as 
these two options are not compatible. You can either hear the beep, or the 
pronounced text.   

To activate the beep sound:  

• Click the Sound button  on the toolbar or select Sound from 
the Options menu. The beep is activated. You can hear it during 
scanning.  
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CHAPTER 6  
LEARN HOW TO... 

CUSTOMIZE/SAVE/REOPEN SETTINGS 

Customize the default settings 

When you launch the IRISPen, options are selected by default. 
Some default presets are also available from the IRISPen Wizard 
(see: Starting up, The IRISPen Wizard). These selected options 
form the "default settings", also referred to as the "factory settings".  
You will of course change these default settings to make the 
IRISPen perfectly fit your particular needs. The changed settings 
become your own settings. They will normally be kept until you 
next modify them (see below).  

Save Settings on Exit 

 

The option Save Settings on Exit from the Options menu (toolbar) 
is enabled by default. This means that the settings that are active 
when closing the application will be active again when you next 
open the application. If you have modified the IRISPen Wizard 
presets, these will also be saved.  
If you do not want to save your settings on exit, either disable the 
option Save Settings on Exit from the Options menu (toolbar), or 
select the option Reset to Factory Settings from the File menu 
before you exit.  
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Save Settings 

You can save your settings in a file with the Save Settings option 
from the File menu. You will be able to reopen those settings 
whenever needed.  
With the Save Settings option, you can save as many sets of 
settings as you wish. All you need to do is give them a name and 
save them with the *.IPC extension.  

 

Open Settings 

At any moment in time, you can reopen any saved settings. To open 
your saved settings, select Open Settings from the File menu and 
open the corresponding file with the *.IPC extension, or directly 
select the required file from the File menu (the last four saved files 
are listed).  
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READ DOT MATRIX TEXT 

Dot matrix printed text is text which is made of isolated, separated 
dots. The IRISPen can read such text.  

 

To read dot matrix text:  

• Select the option Dot matrix in the Application window. See: 
Basic settings, Reading options, Other.  
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• Operate as for any other type of printed data: just slide the pen 
scanner over the text line. See: Introducing the IRISPen, How 
does it work?  

Warning:  
Select the Dot matrix option only if you intend to read so-called "draft" or "9 
pin" dot matrix symbols. Do not select this option if you want to read letter 
quality dot matrix printing, also called "25 pin" or "NLQ" (Near Letter 
Quality) dot matrix, or other "normal" printing.  

READ SMALL PRINT 

The IRISPen scanning band is 0.41" (10.5mm.) high. It can thus 
read characters having point sizes of 8 to 20.  

 

If you have to read data printed in a font size smaller than 10 point, 
you must activate the Small print option. This will help you get 
optimized results with the IRISPen.   

 

To read small text:  

• Select the option Small print in the Application window. See: 
Basic settings, Reading options, Other.  

 

• Operate as for any other type of printed data: just slide the pen 
scanner over the text line. See: Introducing the IRISPen, How 
does it work?  

Warning:  
Do not use the Small print option to read text above 10 points. This would 
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decrease the recognition accuracy and would slow down the operation 
substantially.  

READ NUMERIC DATA 

The IRISPen is able to read all machine-printed figures. The 
recognition includes special characters, mathematical symbols, 
punctuation marks, currencies, etc. You can thus read all types of 
data such as: digits, codes, amounts, dates, account numbers, 
numeric tables, etc.    
The set of characters used by the software to read such data is the 
same for all languages. However, you can freely customize this 
character set (see: Frequent command: Character Subset).  

Default character subset used:   

 

To read numeric data:  

• In the Application window, select the Numeric scan type. See: 
Basic settings, Reading options, Scan type.  

 

• If necessary, customize the default character subset in the 
Character subset window (click Character Subset on the 
toolbar, or select Character Subset from the Settings menu). 
See: Frequent commands, Character Subset.  
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• Slide your pen over the numeric data. Operate as for any other 
type of printed data. See: Introducing the IRISPen, How does 
it work?  

How to get auditive feedback?  

You can activate the speech feature to get an auditive feedback of 
the scanned data. The speech feature incorporates intelligent 
routines that allow it to read out numbers, telephone numbers, dates, 
etc. Also see: Frequent commands, Speech Synthesis.  

READ HANDPRINTING 

The IRISPen is able to read handprinted numbers and handprinted 
capital letters in languages using the Latin alphabet*. When reading 
handprinted numeric or alphanumeric data, the software also detects 
the dot, comma and hyphen symbols. You can thus read bank 
account numbers, amounts, etc. 

(*) The reading of handprinting is not available in languages using another 
alphabet. Check the list of available languages in the Application window, 
Reading options,  Language field. 

 

 

What is handprinting? 

Warning: 
Handprinting vs. handwriting  
The IRISPen reads handprinting, not handwriting. Handwriting corresponds 
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to continuous, "cursive" writing. The symbols within a word are linked and it 
is impossible for the software to know where one symbol ends and another 
starts. With handprinting, on the contrary, the symbols are separated and the 
IRISPen can isolate the individual characters.   
  

To read handprinting:  

• In the Application window, select the Handprinting scan type, 
then select a language in the Language field. See: Basic 
settings, Reading options, Scan type, Language.  

 

• Check the handprinting settings in the Handprinting window 
(click Handprinting on the toolbar, or select Handprinting 
from the Settings menu). Adjust the settings if necessary. See: 
Frequent commands, Handprinting.  

 

• Slide your pen over the handprinted data. Operate as for any 
other type of printed data. See: Introducing the IRISPen, How 
does it work?  
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How to read handprinting alongside other data?  

If you intend to read handprinting alongside other data, you will 
need to switch from one scan type to the other, then scan each type 
of data.  

Tip: 
To switch quickly from one scan type to the other, you can also:  
- program a pen button: a click on a pen button suffices to switch scan type, 
see: Frequent commands, Pen Buttons. 
- program a hotkey: pressing the hotkey suffices to switch scan type, see: 
Learn how to... Program hotkeys. 
The Switch scan type option makes you get to the next reading mode in the 
list of scan types (you will get from Text to Numeric, from Numeric to 
Black&White image, etc.). Remember that the scan type is always specified 
in the Status window. 

How to get auditive feedback?  

You can activate the speech feature to get an auditive feedback of 
the scanned data. The speech feature incorporates intelligent 
routines that allow it to read out numbers, telephone numbers, dates, 
etc. Also see: Frequent commands, Speech Synthesis.   

READ BARCODES 

Barcodes are composed of parallel bars and spaces. The IRISPen 
analyzes the succession of bars to extract the characters contained in 
the barcodes. The recognized characters are further inserted to the 
target application.  
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The IRISPen supports all widespread barcode standards and 
types, including the 2D barcodes PDF 417 and QR barcode. The 
IRISPen supports bearer bars drawn around the barcodes.  

To be legible, the barcodes must be well-contrasted and printed 
with laserprinters and inkjet printers (not matrix printers), and meet 
the following conditions:  
- The barcode must be at least 0.3" (0.75 cm) high 
- The narrow bar should be at least 12 mils (0.012" or 0.3 mm.). 
Do not try to read tinier barcodes, the resolution of the pen scanner 
will not suffice.   

To read barcodes:  

• In the Application window, select the Barcodes scan type. See: 
Basic settings, Reading options, Scan type.  
You do not have to indicate which barcode type you are going to 
read. Even various types of barcodes can be mixed for the 
scanning. The IRISPen will automatically detect the barcode 
type and read it.  

• If you want to read barcodes on top of another type of data, 
select the Barcodes option in the Application window. See: 
Basic settings, Reading options, Other. 
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• If you want to limit the reading to specific barcodes, make the 
software verify checksums, authorize partial read, or read out-of-
specs barcodes, you must fine-tune the barcode reading in the 
Barcodes window. See: Frequent commands, Barcodes.  

• Operate exactly as for any other data: just slide the pen scanner 
over the barcode. The middle of the barcode should be 
positioned just in front of the pen scanner guide line. Follow the 
instructions given under: Introducing the IRISPen, How does it 
work? 
 
! Do not try to read several barcodes per scan. Only one barcode 
can be read at a time.  

 

Scanning tips... 

Tip:  
Scan on a flat, stable surface  
You are recommended to scan on a flat, stable surface. Although you may 
succeed reading some barcodes on physical objects such as bottles, boxes, 
etc., remember that  the IRISPen is a productivity tool meant for the office 
environment and is not intended to industrial applications.  

Tip: 
Set the brightness correctly 
Set the brightness correctly in the Scan Test window. If the barcode images 
are too light, they contain white spaces where none were intended. If the 
images are too dark, two narrow bars form a single wide one, a white space 
between two black bars become filled in, etc.  

Tip:  
Scan from left to right or from right to left 
You can scan your barcodes from left to right or from right to left without 
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having to change the scanning direction.   
  

Tip:  
Tell the software if the quality is poor 
If the barcode quality is poor, use the barcode quality option in the Barcodes 
window (see: Frequent commands, Barcodes) to make the software use 
additional intelligent routines. Make several scanning tests if necessary.  

Tip:  
Activate the speech synthesis 
Speech synthesis not only applies to text but to all legible data such as 
barcodes. You can thus activate the speech to get an auditive feedback of 
your barcodes. See: Frequent commands, Speech Synthesis. 

SCAN MULTIPLE LINES 

You can scan multiple lines at the same time, i.e. within the same 
scan. This is particularly useful if you want to capture whole 
excerpts of text from books, magazines, etc.  
The various lines of text will be buffered, then released with the 
click on a pen button.  

To read multiple lines:  

• In the Application window, select the option Multilines. See: 
Basic settings, Scanning mode.  

 

• Scan the various lines one by one. Make sure that each line is 
positioned directly in front of the pen's guide line.  
After each scanned line, the Status window displays the message 
"Press pen button to flush". Go on scanning the next line 
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immediately.  
 
Important:  
The pen scanning band is 0.41" (10.5mm.) high and covers in 
many cases several lines of text. This does not mean that all 
these lines are being read. Only one line, the central one, is 
picked and recognized by the pen. You must thus scan each line 
separately and make sure it is positioned right in the center of the 
scanning head.    

 

• At the end of your scan, click any pen button to insert the data 
into the active application. 

SCAN FROM RIGHT TO LEFT 

By default, the pen scanner is set to operate from left to right, but 
you can adapt the scanning direction and scan from right to left. 
You will follow this scanning direction if you are left-handed. You 
will also operate this way if you intend to read right-to-left text like 
e.g. in Hebrew.  

To operate with the pen if you are left-handed:  

• In the Application window, select the option Left-handed 
Scanning under the Options menu.  

 

• Take the pen scanner in your left hand and turn it the other way 
around so as to lean it to the left. Position it at the right end of 
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the text line and slide it over the line from right to left. Make 
sure you hold the pen with the right angle. See: Introducing the 
IRISPen, How does it work? 

To scan right-to-left text (right-handed users):  

• Simply take the pen scanner in your left hand and turn it the 
other way around so as to lean it to the left. Position it at the 
right end of the text line and slide it over the line from right to 
left. Make sure you hold the pen with the right angle. See: 
Introducing the IRISPen, How does it work? 

To scan right-to-left text if you are left-handed:  

• Operate exactly the same way as if you were right-handed (see 
above).  
Note: If you select Hebrew as recognition language in the 
Application window, the option Left-handed Scanning will be 
grayed out as right- and left-handed users operate the same way. 

SCAN NEGATIVE IMAGES 

With the IRISPen, you can scan negative images, i.e. light text or 
graphics on a dark background. The image produced by scanning is 
automatically inverted by the software and displayed in the Scan 
Test window: the black pixels will become white, and the white 
pixels will become black. The recognition is carried out on the 
inverted image.  
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To scan negative images:  

• In the Application window, select Negative Image from the 
Options menu.  
The "Negative" option appears in the Status window. The 
IRISPen is ready to scan negative images.  

 

• Operate as for any other type of printed data: just slide the pen 
scanner over the text line. See: Introducing the IRISPen, How 
does it work?  

• Once you are finished with negative images, do not forget to 
disable Negative Image in the Options menu.  

SCAN VERTICAL TEXT (OPTIONAL) 

If you intend to read some Asian vertical text, you must tell the 
software that the text flow is vertical rather than horizontal. The 
new text flow will be indicated in the Status window.  
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To scan vertical text:  

• In the Application window, select the required Asian language 
in the Language field, then select Scan Vertical Text from the 
Options menu.  

 

• Rotate your document 90° counterclockwise and slide the pen 
scanner over the text line from left to right. Use your pen 
appropriately, see: Introducing the IRISPen, How does it 
work?.  
The Image Quality Check window appears vertically. The Scan 
Test window remains horizontal but the image is rotated. 
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DEFINE THE SYMBOL FOR UNKNOWN 
CHARACTERS 

If characters are not properly recognized by the IRISPen, they are 
by default represented by a tilde, i.e. a "~" symbol, in the 
recognition result. If you wish to, you can choose another symbol. 

   

To define a custom symbol for unknown characters:   

• In the Application window, select the option Unknown Symbol 
from the Settings menu.  

 

• Replace the symbol in the required field, then click OK to 
confirm.  

 

REPLACE A CHARACTER STRING 

Once you have recognized some data with the IRISPen, you can 
have this data replaced by some other data before it is inserted in 
your active application. This is particularly interesting if you want 
to use specific terms or symbols that were not present on the 
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original document. For example, you can replace the currency 
"USD" that appears on the original document by the corresponding 
symbol "$" in your active application. You can replace an 
abbreviation by its full name, you can erase data, e.g. replace "$" by 
nothing so that  "$2.99" becomes "2.99", etc.   

 

 

You can replace a recognized character or character string by: other 
characters, keyboard commands or any combination of all.  

To replace a character or a character string:  

• In the Application window, select the option Replace 
Character String from the Settings menu.  

 

By default, no character conversion is defined in the Character 
String Conversion window.  

• Click on Add to define a new string conversion. Introduce the 
required characters/commands in the proposed fields, then click 
OK to confirm. Use the Character map to easily key in the 
needed characters. 
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Scanned string: Type in the character or character string that will be 
scanned and recognized. 

Converted string: Type in the data into which the scanned string has 
to be converted. You can type in a character, character string, a 
keyboard command, or any combination of all.  

Character map: Click the button to access the whole list of available 
characters. To introduce character(s) in a field, first position you 
cursor in the target field, then click on the required character(s) in the 
map. The character(s) is(are) automatically inserted.  

Once string conversions have been defined, you can edit or 
delete them by clicking on Edit or Delete. You can also browse 
the list with the Up and Down buttons.   

 

REPLACE VERTICAL LINES 

The IRISPen is able to detect and replace vertical lines separating 
data as e.g. table columns. By default, the software replaces vertical 
lines by the <Tab> command. This means that each time it 
encounters a vertical line during scanning, it executes a tabulation 
in your target application. If your target application is a spreadsheet, 
the <Tab> moves your cursor to the next cell and the various bits of 
data are inserted in separate cells.  
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Various keyboard commands are proposed for the conversion, but 
you will also be able to replace vertical lines by characters or any 
combination of characters and commands.  

Tip:  
How to recompose a whole table?  
If on top of the default <Tab> command, you add the line ending code 
<Home> <Cursor Down> (see: Frequent commands, Delimiters), you 
cursor will be relocated on the next row after each scanned line. By doing so, 
you will be able to recompose a whole table. 

 

 

To replace vertical lines in the target application:  

• In the Application window, select Replace Vertical Lines from 
the Settings menu, then select one of the proposed keyboard 
commands (by default, the command <Tab> is selected).   
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Select Custom to introduce your own set of conversion, then 
click OK to confirm. You can execute any keyboard command, 
add characters, or execute any combination of all.  

 

Tip:  
If your table does not contain vertical bars, the easiest procedure is to quickly 
add them on the original document with a pen and a ruler.  

Tip:  
If your table does not contain vertical bars, remember that you can always 
replace scanned characters by a cursor command. To insert, e.g. "2.55$ 
 5.99$" in a worksheet, you can replace the symbol "$" by the cursor 
command <Tab> to place the individual figures in separate cells. See: Learn 
how to... Replace a character string. 
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PROGRAM HOTKEYS 

The IRISPen allows you to program hotkeys for the execution of 
the following commands:  
- Restore the application (reopen the Application window) 
- Switch scan type (switch from one scan type to the next one - see: 
Basic settings, Reading options, Scan type) 
- Repeat speech (repeat the last utterance pronounced with the 
speech synthesis) 
This will make your work quicker and easier. 

To program hotkeys for the proposed commands:  

• In the Application window, select Hotkeys from the Settings 
menu on the toolbar.  

 

• Define a hotkey for one or several available commands. Operate 
as follows:  
- tick either the ALT or CTRL key 
- introduce the clipboard key to be used in the key box 
E.g.: ALT+X to restore the application. 
 
Do not use key combinations that are used by your target 
application, such as: Ctrl+V in Microsoft Word. 

 

• Click OK to confirm.    
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